
READ ME for Eyewitness Virtual
Reality Bird
Introduction

The information in this file is designed to address most of the 
problems you may encounter when using any multimedia title. If you 
are having problems with Eyewitness Virtual Reality Bird, please take 
a look at the items listed in the table of contents to see if your 
particular problem is addressed. If you are still having problems, 
please call our technical support number with details of the problem 
including any error messages that were produced and the full 
specification of your computer.

The numbers in London, United Kingdom are:

Telephone: 0171 753 3488
Fax: 0171 753 7575
E-mail: DKMM@DKMM.CO.UK

The numbers in New York, USA are: 

Telephone: 1-800 DKMM 575
Fax: 212 213 5240
E-mail: DKMM@phantom.com

To move around this file, press Page Up and Page Down, or click in 
the vertical scroll bar. You can print this file by selecting the Print 
command from the File menu.

More help on making the best use of all the features within 
Eyewitness Virtual Reality Bird is available once you have started the 
product. Click on the help icon in Eyewitness Virtual Reality Bird. 
Click on 'Having Problems?' to access more information (you will also
find a reminder of some of the main points in this document).
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A. Setup and Uninstall Notes

Setup
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If the Setup program fails with an error message indicating a 'General
Protection Fault' or 'Cannot change properties of...' then you should 
check whether Norton AntiVirus software, or any other virus checking 
software, is installed on your machine. It is recognized that the 
presence of Norton AntiVirus, and certain other virus checking 
software, causes problems with the Eyewitness Virtual Reality Bird 
Setup program. To overcome problems with Norton AntiVirus, type 
the letters 'REM' (followed by a space) at the beginning of any lines 
that have the text 'NAV' in them in the 'AUTOEXEC.BAT' and the 
'CONFIG.SYS' files. Also, type a semicolon ';' at the beginning of the 
line containing the 'LOAD =' entry in the 'WIN.INI' file (The letters 
'REM' at the beginning of a line in the 'AUTOEXEC.BAT' and 
'CONFIG.SYS' files, and the semicolon at the beginning of a line in 
the 'WIN.INI' file, cause the line to be ignored). Now exit Windows 
and restart your computer, then try to run Setup again. Similar steps 
can be taken to overcome problems with other virus checking 
software.

If you are using Windows 95 you can start the program by going to 
the Task Bar and choosing Run from the Start menu.  Type ‘D:\
SETUP’, where D is the letter of your CD-ROM drive, then follow the 
instructions which appear on your screen.

Uninstall

The Eyewitness Virtual Reality Bird CD-ROM contains an Uninstall 
program which is automatically installed in the DK Multimedia 
program group on your computer. If you decide that you no longer 
wish Eyewitness Virtual Reality Bird on your computer (or any other 
title for that matter), you can use Uninstall to remove it. Simply 
double-click on the 'Uninstall' icon to display a list of titles on your 
computer which can be uninstalled. Highlight the titles you wish to 
uninstall, then click the 'Delete' button. Uninstall does the rest for you!

Users of Windows 95 should note that they should use the Uninstall 
program which is provided with Eyewitness Virtual Reality Bird, not 
that provided with Windows 95.

Eyewitness Virtual Reality Bird And Windows 95

The Task Bar
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The Task Bar at the bottom of the screen in Windows 95 forces 
Eyewitness Virtual Reality Bird off the top of the screen, meaning that
not all of the Eyewitness Virtual Reality Bird screen is visible. This 
happens because Windows 95 tells all programs the screen is 
actually smaller than it is, so that they do not cover the Task Bar. The 
full Eyewitness Virtual Reality Bird screen may be viewed by selecting
the top edge of the Task Bar with the left mouse button and dragging 
it down and out of sight before running Eyewitness Virtual Reality 
Bird. Alternatively, click on 'Properties' using the left hand mouse 
button and turn on the 'Auto Hide' option.

Media Player Errors

Eyewitness Virtual Reality Bird will work with Windows 95; however, 
the Setup program will try to update the Registration database for 
Media Player (MPLAYER.EXE) and its help file (MPLAYER.HLP). 
This causes Windows 95 to report the following error when you run 
Media Player:

"Media Player settings have been changed by another program. As a 
result, Media Player will not work correctly.

To fix this problem, click Yes. To exit without fixing this problem, click 
No."

You should simply click 'YES' to solve this problem.

Also, when reading the rest of this document, please bear in mind 
that a lot of the filenames mentioned, and optimization tips described 
below, are written for Windows 3.1 or 3.11 and are not applicable to 
Windows 95, except where specified. For more information about 
Windows 95, please read the Windows 95 documentation.

B. Screen Display Notes

Screen Resolution

Dorling Kindersley Multimedia products have been designed to look 
their best with a screen resolution of 640 x 480 pixels. All screen 
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images are created in this size, and will completely fill the screen at 
this resolution. This means that running your screen at a higher 
resolution (such as 1024 x 768) will result in a smaller image of 
Eyewitness Virtual Reality Bird being displayed. (It is NOT possible to
maximize the product to fill screens with a resolution higher than 640 
x 480.)

256 Colors

Eyewitness Virtual Reality Bird uses 256-color images and we 
recommend that you set your display driver to 256-color mode. You 
can run the Windows Setup program from the Main program group to 
identify your current driver display setting, and if necessary, to change
your display driver. To change to the Standard VGA (SVGA) driver 
see below ( for more information, check your Windows 
documentation):

Installing Microsoft's Super VGA Driver

These instructions assume that you have version 3.1 or 3.11 of 
Windows and a Super VGA compatible display adapter. If you are not 
sure, please refer to your documentation or ask your computer 
administrator.

Please make sure that you have a back-up copy of your original 
display drivers before installing the SVGA driver, in case you need to 
reinstall them later.

This is how you install the SVGA driver:

1. In Windows 'Program Manager', double click on 'Windows Setup' in
the 'Main' program group.

2. Select 'Change System Settings...' from the 'Options' menu.

3. Select 'Other display (Requires disk from OEM)...' at the bottom of 
the 'Display' drop-down list.

4. Type over the 'A:\' and replace it with 'D:\WINGDRV\MSSVGA' 
(where D is the letter of your CD-ROM drive).
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5. Select 'Super VGA 640x480 256 colors' and click on 'OK'.

6. Make sure you exit Windows and restart.

16 Colors

If your computer is running in 16-color mode, and your display card 
supports 256-colors, you can run the Windows Setup program to 
change the display driver. This will enhance the image quality of 
Eyewitness Virtual Reality Bird. To find out if your display card 
supports 256-colors, please consult the documentation that 
accompanied your computer or display adapter.

Images appear in monochrome

Some color display cards may display Eyewitness Virtual Reality Bird 
images in black and white. If this happens, you should upgrade your 
color display driver. Contact the supplier or manufacturer of your 
display card to check that you have the latest display drivers.

Images are truncated

The designs of some display drivers are to provide large fonts. If your 
system is using one of these, any images in the main window will 
appear slightly truncated. You can run the Windows Setup program to
change the default display driver to one that does not default to large 
fonts.

ATI cards

Some of the advanced features of ATI cards may be incompatible 
with Eyewitness Virtual Reality Bird. In particular, for the more 
powerful ATI cards, you may find that the '256-color palette' of the 'ATI
Control Panel' must be set to 'ON'. For more information, see your 
display card documentation.

Other display problems
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If you continue to have problems displaying images or running 
animations in Eyewitness Virtual Reality Bird, you may be able to 
isolate them by going through the following process:

1. Run the Windows Setup application, and check your display driver. 
If it is VGA, then try running Windows in Standard Mode by exiting 
and typing 'WIN /S' at the MS-DOS prompt. If Eyewitness Virtual 
Reality Bird works, then try running Windows in enhanced mode by 
exiting Windows and typing 'WIN /D:XV' at the MS-DOS prompt. If 
this also solves the problems, then edit the '[386Enh]' section in your 
'SYSTEM.INI' file so that these entries read:

EMMEXCLUDE=A000-EFFF
VIRTUALHDIRQ=OFF

2. If the display driver shown in the Windows Setup application is not 
VGA, then try using the 'Change Systems Settings...' in the 'Options' 
menu to change the display driver to VGA. If this solves the problem, 
consider using a different display driver provided by your display card 
manufacturer. If not, you should contact your display card 
manufacturer for advice.

Remember that Eyewitness Virtual Reality Bird uses 256-color 
images, and will not look its best using the 16-color mode of the 
standard VGA driver.

C. Problems with Video or Animations

If you get an error message when you try to play video, you may not 
have the correct video drivers installed. During Setup, this special 
system software should have been installed, and Windows should be 
restarted afterwards to make this software work. If you did not restart 
Windows, do so before attempting to run Eyewitness Virtual Reality 
Bird again. 

If video plays jerkily, this may be because you have an old version of 
the video drivers installed - follow the advice in the above paragraph. 
Alternatively, your system may have too little memory available to run 
video smoothly - consult Section F for further advice.

Some users may encounter problems playing the large video panel 
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on the base specification machine (486SX, 25MHz, 4MB RAM, 
double-speed CD-ROM)

WinG - Windows Games Interface

This product uses the WinG Windows Games Drivers. These are 
installed during Setup. The first time you run Eyewitness Virtual 
Museum Bird WinG profiles your display for optimum performance. 
This takes a couple of minutes. It is only performed once. Certain 
older video display drivers are not compatible with WinG, in which 
case you get the following message when you start the product:

"WinG has encountered a problem with your video display driver. 
Contact the manufacturer of your video card to obtain the most recent
driver. Your WinG applications will run, but at reduced speed."

We recommend that you obtain and install the most recent driver for 
your video card for best results, although installing the standard 
Windows SVGA 640 x 480 x 256 color driver works well on the 
machine configurations tested at Dorling Kindersley Multimedia. We 
have included the generic Windows SVGA driver, in the WINGDRV 
directory on the CD-ROM . This may be helpful but we should point 
out that it is not produced by Dorling Kindersley Multimedia and is 
unsupported by us. To install the SVGA driver, follow the instructions 
in Installing Microsoft's Super VGA Driver, found in section B. Screen 
Display Notes. For more information, check your Windows 
documentation, your display adapter manual, or contact your supplier.

(NB: changing your video card driver and restarting Windows AFTER 
you've installed Eyewitness Virtual Reality Bird may result in the 
WinG 'Profiling' display running within the product the first time you 
ask to play a video. Don't be alarmed - this only happens once and 
should not cause any problems.)

Cirrus Logic 5434 Graphics cards (and other graphics cards)

If video in Eyewitness Virtual Reality Bird plays with a distorted color 
pallet, or looks as though the image is either blurred or like a 
photographic negative, then the likely cause is a problem with Cirrus 
Logic 5434 graphics card drivers. If you have a Cirrus Logic 5434 
graphics card you should obtain the latest drivers to fix the problem. 
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Problems with Diamond Stealth Drivers

If you are having problems with video, and you have a Diamond 
Stealth 64 driver, in the system.ini file the setting “DeviceBitmaps=0” 
(in the [STLTH64.DRV] section) needs to be changed to 1.  If this 
section is missing altogether, it should be added.

D. Audio Problems

There are many possible causes of audio problems. Remember, for 
example, that your computer can only play one sound at a time, so 
when another application is playing a sound, Eyewitness Virtual 
Reality Bird cannot do so. Most applications only prevent other 
programs from playing a sound when they themselves are doing so. 
However, some applications, such as certain Screen Savers, remove 
audio capability from all other Windows applications. If you have such
an application, you should turn it off when you are running 
Eyewitness Virtual Reality Bird. 

Also, Eyewitness Virtual Reality Bird requires a sound card to be 
present, as all the animations in the product are synchronized to run 
frame-by-frame with their accompanying soundtrack. Therefore, 
Eyewitness Virtual Reality Bird will not run without a sound card.

Sound Decompression Drivers

The following problems may result from running Eyewitness Virtual 
Reality Bird without the correct sound decompression drivers:

- An error message concerning the sound decompression drivers 
(ADPCM) when you try to run the program.
- Unintelligible sound output from Eyewitness Virtual Reality Bird.
- Speeded up sound in some parts of Eyewitness Virtual Reality Bird 
(but not in animations).

If you are running Windows 3.1 or 3.11, to overcome any of these 
problems you should:

1. Exit Windows, and in the Windows system directory you should 
rename the following files: 'MSACM.DRV' and 'MSADPCM.DRV'.
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2. Now restart Windows and run the Setup program for Eyewitness 
Virtual Reality Bird again. Setup will enable the sound decompression
drivers to be copied from the CD. Once Setup is completed, Windows
must be restarted to complete the installation procedure. The 
application should now run correctly.

If you are running Windows 95, to overcome any of these problems 
we suggest using the sound decompression drivers supplied with 
Windows 95. To do this:

1. From the 'Start' menu, choose 'Settings', then choose 'Control 
Panel'.

2. Click the 'Add/Remove Programs' icon. The 'Add/Remove 
Programs Properties' dialogue box will appear.

3. Select the 'Windows Setup' tab.

4. Highlight the 'Multimedia' option in the list, then select the 'Details' 
button. The Multimedia dialogue box will appear.

5. If the 'Audio Compression' box is not checked, you should do this 
now. Click 'OK' and then follow the instructions that appear on the 
screen.

6. If the 'Audio Compression' box is checked, you should click to 
deselect it first. Select 'OK', and then follow the instructions that 
appear on the screen. Finally, repeat the whole operation to re-check 
the 'Audio Compression' box. This ensures that the up-to-date drivers
are actually installed by Windows 95, and it doesn't just 'think' they 
are.

If the above steps do not help, you should ensure that the system 
does not have a third party ADPCM driver installed, or that the priority
for decompression drivers is wrong. To do this:

1. From the 'Start' menu, choose 'Settings', then choose 'Control 
Panel'.

2. Click the 'Multimedia' icon. The 'Multimedia Properties' dialogue will
now appear.
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3. Select the 'Advanced' tab.

4. Click the '+' symbol next to 'Audio Compression codecs'.

5. Ensure that the top three CODECs are listed in the same order as 
shown below:

- Microsoft CCITT G.711 A-Law and u-Law CODEC
- Microsoft IMA ADPCM CODEC
- Microsoft ADPCM CODEC

If they are, there is a different problem with the sound card software.

6. If the CODECs are not listed in the order specified above, you 
should select the top three CODECs in the list (one at a time), and 
click the properties button.

7. For each CODEC you do this to, a dialogue box will appear which 
allows you to change the priority setting of the CODEC, to move it 
further down the list.

If the above proecdure does not solve your problem you may also try 
the following steps to disable all CODECs listed which contain the 
text 'ADPCM' (apart from the 'Microsoft ADPCM CODEC'):

1. From the 'Start' menu, choose 'Settings', then choose 'Control 
Panel'.

2. Click the 'Multimedia' icon. The 'Multimedia Properties' dialogue 
box will now appear.

3. Select the 'Advanced' tab.

4. Select the CODEC you wish to disable, from the list.

5. Select the 'Properties' tab to display the dialogue above to the 
right.

6. Select 'Do not use this audio codec'.

7. Select 'OK'. Repeat the procedure for all other relevant CODECs.
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Audio is fuzzy or distorted

There are a number of possible causes of fuzzy or distorted sounds. 
Problems are often caused by low-quality speakers, set to high or 
maximum volume, or powered by failing batteries. You should also be
aware that some speakers are not capable of playing low frequency 
sounds properly.

Some sound cards have software that allows you to adjust the 
volume AND tone of the sound. If this is the case with your sound 
card, start with these tone controls set in the mid position and your 
volume level set between 80% - 100%. This should give a clear signal
with no distortion. Check your sound card documentation for the 
optimum settings.

If treble or bass is added in this software you must reduce the volume
to compensate, or distortion will occur. Check your sound card 
documentation for the optimum settings.

Powered speakers are best and, if possible, should be placed either 
side of the screen. You may need to adjust the position of these 
speakers slightly if the magnets in the speakers are unshielded and 
cause discoloration and distortion of the image.

If your CD-ROM is not at least double speed and MPC compatible, 
then the sound may play badly or be interrupted when playing. Check
your CD-ROM's documentation to ensure that it meets the following 
requirements:

- It has an average seek time of less than one second;
- It has a transfer rate of at least 300Kb per second while using less 
than 40% of the CPU bandwidth.

Sound plays too quietly

Make sure the volume is set to an audible level. Check the sound 
card itself, the speakers or headphones if they have a volume control,
and any software that may have been supplied with your sound card 
that can change the volume level. If there is mute button in the audio 
software or on the speaker, check that this is not activated.

If the sound controls are set to an audible level, then you may have a 
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problem with the way your sound card drivers are set up. Check they 
are set up correctly (from the 'Drivers' section of the 'Control Panel') 
and, if necessary, reinstall them. Consult your sound card 
documentation for more detailed information.

If you do not have a sound card installed on your PC and you are 
using the internal PC speaker driver, Eyewitness Virtual Reality Bird 
will not work. You will need to install a sound card and sound card 
drivers to run the program.

EISA machines

If you are running Eyewitness Virtual Reality Bird on an EISA 
machine, and the sound appears scratchy, you should change the 
DMA channel on the sound card to DMA 7. Consult your sound card 
documentation for more detailed information.

Media Vision sound cards

Please make sure that you have the latest drivers for your Media 
Vision sound card. Some earlier drivers cause problems for 
Eyewitness Virtual Reality Bird. Contact Media Vision for current 
driver information.

E. CD-ROM Problems

If Eyewitness Virtual Reality Bird has problems finding the data files it 
needs from its CD-ROM, you may see a message asking you to 
select the drive that contains the files, or you may see an error 
message with the options to abort, retry or fail. To find what has 
caused the problem, do the following:

1. Ensure that the Eyewitness Virtual Reality Bird CD has been 
correctly inserted into the CD-ROM drive.

2. Check that Eyewitness Virtual Reality Bird is looking in the right 
place for the Compact Disc drive. If, for example, the drive letter has 
changed as a result of a system change, such as adding or removing 
a RAM-disk or other device, then Eyewitness Virtual Reality Bird will 
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fail to find the CD-ROM. You can check that the drive letter is correct 
by using Windows File Manager to see which letter is assigned to the 
Compact Disc drive. If your are running Eyewitness Virtual Reality 
Bird under Windows 95, check the drive letter is correct by double-
clicking on the 'My Computer' icon and then looking below the icon 
which represents your CD-ROM drive.

3. If you have an external CD-ROM drive, make sure that it is plugged
in, turned on, and connected to your computer. You may need to 
check the documentation that came with the drive.

4. Verify that your Compact Disc drive is MPC-compatible, and meets 
the following requirements:

- It has an average seek time of less than one second;
- It has a transfer rate of at least 300Kb per second while using less 
than 40% of the CPU bandwidth.

F. Running Out of Memory or Running Slowly

Eyewitness Virtual Reality Bird uses your computer's system memory 
to display pictures. If you find that Eyewitness Virtual Reality Bird runs
slowly or if you come across out-of-memory errors, the program 
probably does not have enough memory. Consider doing the 
following to improve your computer's performance:

1. Close any unnecessary applications, including any DOS Terminate 
and Stay Resident programs (TSR's) you may have installed.

2. If the program is still running slowly, you can improve its 
performance by selecting the 'Options' screen from within Eyewitness
Virtual Reality Bird and turning off 'transitions'.

3. Check that your computer has at least 4Mb of memory. You can do 
this by leaving Windows, and typing 'MEM' at the system prompt. 
Look for total memory in the Total column. If the figure reads 4096Kb 
or more, then you have at least 4Mb of memory. If you have less than
4Mb (minimum 4096Kb) of memory, then you need to install some 
more.

4. Check that Windows has sufficient memory available for 
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Eyewitness Virtual Reality Bird. You can do this by selecting 'About 
Program Manager' from the 'Help' menu in Program Manager. If you 
are running Eyewitness Virtual Reality Bird under Windows 95 you 
can do this by double clicking on the 'My Computer' icon, then select 
'Help', and then select 'About Windows 95'. The memory available 
should be a least 8,192Kb (don't be confused by looking for more 
memory in this step than you did in step 3 above. The extra memory 
here indicates the presence of a Windows swap file). You may find 
more memory becomes available if you restart Windows. If the figure 
is less than 8,192Kb this indicates that either you have no Windows 
swap file or that the swap file is too small. If this is the case, you 
should follow step 5 below.

5. If you are running Windows in Enhanced mode, set up a 
permanent Windows swap file on your hard disk of a least 4,000kb. 
You can do this by following the instructions in your Windows 
documentation.

6. On machines with only 4Mb of memory, restrict the SMARTDRV 
setting that controls the size of the disk cache for use inside Windows
to 512K or less. If you are running Windows for Workgroups 3.11 and 
using 32-bit disk access, make sure that the SMARTDRV settings in 
your AUTOEXEC.BAT file enable SMARTDRV to cache your CD-
ROM drive efficiently. Consult your Windows documentation for 
further information on how to check and adjust these settings.

7. If you are running DOS 6.0 or higher, then you can run the 
MEMMAKER utility to optimize the memory in your computer. (For 
example, if you answer 'No' to the question 'Do you use any 
programs that need Expanded Memory?', MEMMAKER will free 
further conventional memory by inserting the switch NOEMS in the 
appropriate line in your PC's CONFIG.SYS file.) Consult your 
Windows documentation for further information on using 
MEMMAKER.

8. Clean up your hard disk by defragmenting it. There are a number 
of tools available to carry out this task, including the 'DEFRAG' 
command found in MS-DOS version 6 and later.

9. Check that 'MSCDEX' which appears in the 'AUTOEXEC.BAT' file 
is version 2.23 or later, and appears before the 'SMARTDRV' entry. 
You can do this by typing 'MSCDEX' at the system prompt in MS-
DOS. If in any event no version number is given, then you can be 
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sure that your version of 'MSCDEX' is older than version 2.23. 
Versions of 'MSCDEX' older than 2.23 should be upgraded.

G. Printing

Printing screens from Eyewitness Virtual Reality Bird may take 
several minutes, depending on the type of printer you use. Since 
screen resolution and printer resolution are often different, the 
printout may not match the quality you see on the screen. 

You can change the settings of your printer from within Eyewitness 
Virtual Reality Bird by clicking on the 'dial' icon on the left-hand pillar 
of the console. An 'Options' screen appears. Click on 'Print Setup' to 
display the 'Print Setup' dialogue box. (Please note: an explanation of
the 'Print Setup' dialogue box is available in your Windows 
documentation.)

Some dot-matrix printers may not print pictures properly with the 
'Low/Faster' quality setting in the 'Print Setup' dialog box. On these 
printers, change the quality setting in the 'Printer Settings...' dialog 
box to 'High/Slower.'

Because the pictures can be quite large, you may have difficulty 
copying or printing in low-memory conditions. In this case, follow the 
advice in section F of this file, and try again.

© Dorling Kindersley Multimedia
October 4, 1995
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